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Welcome

Welcome to the first issue of Agora Insight.  
At Agora Consulting Partners we have a long 
held practice of sharing business and technical 
information with our customers, partners and 
friends.  This newsletter is simply a new format 
for that same kind of information sharing.  In 
each issue we will provide timely and valuable 
articles about each of our practice areas:

Custom Application Development

Enterprise Project Management

Business Intelligence

Business Intelligence (BI) is a key enabler 
for organizations to be responsive to their 
environments and turn masses of data into 
actionable insight. In order to reach the 
ultimate goal of monitoring all vital signs of their 
organization and understanding where they are 
heading there are many components that have 
to be in place.  We have found that there are 
four key areas that an organization must  
assess to determine the correct focus for 
their BI initiatives.

1 Understand

To provide maximum value to an organization, 
BI initiatives must be undertaken with a strong 
knowledge of the business’s goals and the user 
environment.  Users and their sponsors need to 
buy in to BI initiatives. Your organization must 
have a commitment to fact based decision 
making and an environment of trust between 
departments.  An overall understanding of the 
Critical Success Factors for the business is also 

vitally important.   Senior Executives need to 
show support for BI by championing a global BI 
strategy and roadmap and providing training to 
all information workers.  Senior Executives can 
best demonstrate their commitment by insisting 
that all business plans and proposals are 
backed up by information from corporate  
BI systems.

2  Collect

Data Capture and Quality - The very 
beginning of the data life cycle is capturing 
the data that will eventually be analyzed and 
studied. Some data, such as sales orders, 
is typically already captured in transactional 
systems. More qualitative information, such as 
customer satisfaction, is often captured in a 
more manual, less rigorous fashion such as in 
Word templates or emails. External information 
from suppliers and industry or demographic 
data is playing an increasingly important role 
in BI.  Businesses need to ensure they have 
access to all necessary data in order to be 
successful in BI initiatives.

Once the data is captured, in order for business 
users to make informed, confident decisions  
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The articles will be on a mix of business 
and technical issues.  This quarter, we have 
articles on Prioritizing Business Intelligence 
Initiatives, Migrating to Project Server 2007 
and building .NET applications in a way that 
allows for easy internationalization.  We will also 
include condensed customer case studies and 
announcements of upcoming events in each 
issue.  For more information on any article visit 
our website at www.agorainc.com.

We hope you enjoy Agora Insight and  
we welcome your feedback and input.
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the data needs to have high integrity.  
This is becoming increasingly important 
as some industries are becoming more 
regulated and data is being provided as part of 
regulatory compliance. Data quality needs to 
be considered at many aspects of the data life 
cycle.  This includes an enterprise wide data 
dictionary and an ongoing strategy for data 
profiling, cleansing and auditing.

Data Integration and Storage - The back 
bone of a BI system are the datamarts and data 
warehouse that brings together information 
from various source systems. Once they are 
in place there are many applications that 
can be built on top of them. Analysis of the 
source system data and understanding the 
relationships between the source system data is 
key to making a successful datamart.

3  Analyze

Data Analysis - Power business users often 
need to be able to analyze data in a more 
flexible, dynamic environment beyond reports. 
Data analysis tools permit them to begin with 
an understandable data model and slice-and-
dice it enabling them to find the answers to the 
questions they are pursuing.

Data Mining - Data Mining provides an 
additional level of sophistication of working with 
the data. It enables business users to perform 
operations such as what-if scenarios and 
forecast into the future. Data mining is typically 
performed by dedicated business analysts 
who are trained in statistical methods, but 
newer tools are being introduced that bring this 
analytical power to every knowledge worker.

4  Deliver

Reporting - Reports are the baseline of 
applications used to support business 
intelligence. Reports often grow in an organic 
fashion within each business unit leading to 
inconsistent construction and duplicated effort. 
By having a centralized, standard reporting 
process, usability and quality of the reports 
increase. As well, the amount of effort required 

to deploy the reports decreases.

Performance Management - BI is the 
foundation on which Performance Management 
is built. BI provides the information with which 
an organization can be measured and compared 
against its critical success factors.  This is the 
stage at which Key Performance Indicators (KPI’s) 
are tracked and displayed and performance 
management methodologies such as Balanced 
Scorecards are utilized.

Dashboard - A BI dashboard brings together all 
the BI components into one place and combines 
it with additional business context. It becomes 
the centralized workspace for the business user. 
Dashboards are usually deployed within a portal 
environment so that they are readily available to all 
knowledge workers.

In each of our BI engagements, we work with 
our customers to go through a comprehensive 
questionnaire to assess each of these areas.  
Although the list seems long and daunting, the 
good news is that most organizations already 
have many of the necessary pieces in place.  
Also, the introduction of more user friendly tools, 
many of which are integrated into software that 
organizations already own, means that putting 
the missing pieces in place can be achieved more 
easily than ever before. 
 
For more information, please visit  
our website at www.agorainc.com/bi

Craig McQueen is Director of Business Intelligence 
Solutions.  He can be reached at: 
cmcqueen@agorainc.com  

or 416-304-1338 x19
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Background

Resource files are utilized by computer 
applications to display culture and language 
specific data.  The data contained in resource 
files can be of any non-executable source, for 
instance, strings, images, and binary data.

There are many benefits of utilizing resource 
files.  With them you can:

•	 Modify the resource data without having to 
recompile your application

•	 Release new culture-specific resource files 
without having to recompile your application

•	 Eliminate the programming complexity for 
supporting multiple cultures

•	 Reduce the size of the main executable 
since the resources are stored in a 
separate file

•	 Reduce your application’s memory usage 
since the resources aren’t loaded into 
memory with the main executable

Resources in the .Net Framework

The .Net Framework uses a hub and spoke 
model for working with resource files.  The 
hub is the main assembly that contains the 
application’s default culture.  The spokes are 
the culture specific satellite assemblies that 
contain the resources for the specific culture.

When a resource cannot be located in the 
spoke, the .Net runtime falls back to the hub.

Visual Studio .Net makes the process of 
creating resource satellite assemblies simple for 
the developer.  It has a built in resource editor 
that allows the developer to modify resource 
files.

When compiling an application within Visual 
Studio that contains resources files, Visual 
Studio will automatically compile the resource 
file into a satellite assembly.

For more technical detail we have provided  
reference links at the end of this article for more 
information. 

Challenges

Even though resource files have simplified 
application internationalization enormously, they 
have also introduced new challenges.

The main challenge with working with 
resource files is having them translated.  In 
a preproduction scenario, the developer 
would send the resources files to a translator.  
Translation can require a significant amount 
time, and during this time, the development 
version of the resource files will most likely be 
modified.  When the translator delivers the 
translated version of the resource files, the 
developer would have to manually merge the 
resource files together.  This is a costly and time 
consuming process.

In a postproduction scenario, often the client 
would like to modify the application’s resources.  
Perhaps they would like to rephrase a sentence, 
change an image, or even introduce an entire 
new culture.  This is all possible with resource 
files, however most clients do not have the 
means to perform these tasks.  The client then 
needs to decide whether they will purchase 
development tools such as Visual Studio .Net 
or if they should contract a developer to handle 
the task.  Either way this can be an expensive 
process.  

Old Solution

In the past, to address these challenges, 
we would store the resources in a custom 
Microsoft Excel spreadsheet.  The Excel 
spreadsheet contained VBScript code that 
would handle the merge challenge.  Also 
by using Excel, it allowed our client to view 
and modify the resources without having to 
purchase a resource file editor.

On the development side, we created a custom 
tool that would convert our Excel files into 
resource files.  These resource files were then 
imported into the project and compiled into 
satellite assemblies.

Although this solution helped improve the 
resource file process, there were still some 
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drawbacks.  Storing the resources in Excel 
exposed additional steps in the development 
environment, which decreased productivity.  Also, 
the client still didn’t have the means to modify 
resources themselves once the application was 
published.

New Solution – The Resource Editor

The Resource Editor is a comprehensive 
Windows application, developed by Agora that 
allows a user to modify any type of resource file.  
It also consists of several features that solve all of 
the above noted challenges.

To address the merge challenge, we built a merge 
feature into the Resource Editor.  Simply open 
a resource file by selecting File > Open.  Then 
to merge another resource file into the opened 
resource file select File > Merge.

The Resource Editor was primarily designed 
for the client.  The Resource Editor allows the 
client to create new resource files, update 
existing resource files and it also generates 
satellite assemblies that can be deployed to their 
published application.

To create a satellite assembly from a resource file, 
simply select Tools > Create Satellite Assembly 

The client no longer needs to purchase expensive 
development tools or contract a developer for 
maintaining their application’s resources.  It can all 
be done using the Resource Editor.

The Resource Editor also dramatically increases 
the developer’s productivity, because there is no 
need for any additional tools or steps for working 
with resources in the development environment.  
The developers can continue to use Visual Studio 
.Net for managing the application’s resources. 

For more information, please visit our 
website at www.agorainc.com/development 

Garry English is a Senior Software Developer.   

He can be reached at genglish@agorainc.com

References

Resources in .Net

http://msdn2.microsoft.com/en-us/library/f45fce5x(VS.71).aspx

ResGen - tool for generating Resource files

http://msdn2.microsoft.com/en-us/library/ccec7sz1(VS.80).aspx

Assembly Linker (AL) - tool for generating satellite assemblies

http://msdn2.microsoft.com/en-us/library/c405shex(VS.71).aspx

Merge Function in Resource Editor

Satellite Assembly Creation in Resource Editor

4

Agora Insight 1.1



Although migrating from Microsoft Project 
Server 2003 to Microsoft Office Project Server 
2007 is well documented on Microsoft TechNet, 
there are a few items that deserve further 
mention.

At a high-level, the complexity of the migration 
increases based on the quantity of SharePoint 
content; and/or if a partial migration is being 
contemplated.

A migration always should be well planned and 
one of the first steps of the planning process 
should be doing an inventory of the current 
system. An inventory allows you to verify the 
success of the migration plus it can identify 
elements that need to be handled pre- or post-
migration. At a minimum, an inventory should 
include:

1.	 A list of projects with project names, 
the custom project fields, the start and 
finish dates, the URL for the SharePoint 
workspace and whether the project is 
externally modified. (Note that for a project 
to be marked as externally modified the 
last modification must have been made 
by something other than MS Project. If 
you modify a project’s custom field’s value 
using PWA that would qualify as externally 
modified.)

2.	 A list of resources with resource names, 
Windows accounts, custom resource fields 
and whether the resource is externally 
modified.

3.	 A list of PWA views noting the grouping 
and filtering defined. 

4.	 The security objects: groups, categories 
and users.

5.	 A detailing of the custom development 
including reports, connections with other 
systems, macros within MS Project, Guides, 
and so on.  

Revisit Security

Installing Project Server 2007 creates the 
standard security groups and categories but 
when the migration utility runs, it migrates the 
security settings from the 2003 database. 
This results in two set of security objects. 
You will need to merge the two sets taking 
into consideration your requirements and the 
permissions new to Project Server 2007.

Update Views

There are a number of data elements that are 
not moved as part of the migration (see the 
Microsoft migration guide for more details), but 
one item that is partially moved is the views. 
The grouping and filtering for views must be 
recreated manually after the migration. 

Don’t Forget!

Client-Side Software  
Don’t forget to co-ordinate the deployment 
of the client-side software (MS Project 2007, 
the PWA ActiveX controls and the necessary 
software to access OLAP views) with your 
migration. 

SharePoint Workspace  
If you are using a customized SharePoint 
Workspace template in Project Server 2003, 
it will not be migrated. Instead you need to 
customize the default 2007 template and 
deploy it in your new environment.

Training  
One key to a successful migration is training, 
particularly for Project Managers so they can 
take advantage of the new features in Project 
Server 2007.

 

For more information please visit our 
website at www.agorainc.com/epm

 

Gord Schmidt is Technical Lead for Enterprise 

Project Management Solutions.  He can be reached 

at gschmidt@agorainc.com or 416-994-4673
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Customer Profile 

With 450+ lawyers in Toronto, Montréal, 
Calgary, Ottawa and New York, Osler provides 
integrated legal services with specialists in 
virtually every area of business law. Osler 
advises many of Canada’s corporate leaders 
as well as U.S. and international clients with 
interests in Canada. Their breadth of legal 
expertise allows them to provide the kind 
of seamless, integrated service their clients 
require.

Challenge

Osler had just completed a formal business 
case development and portfolio optimization 
exercise for its 2008 budget using a manual 
process and were interested in improving 
and automating the process with the 
implementation of a Portfolio Management tool.  

Approach

In early February 2008, Osler engaged 
Agora to implement Microsoft Office Project 
Portfolio Server 2007. Agora used its proven 
implementation methodology to guide the 
implementation. This methodology calls for a 
focused effort on People Change Management, 
Processes and Procedures, the Technical 
Configuration and Training. The engagement 
began with analyzing the current process and 
tools as well as gathering requirements for 

the new solution. We worked with Osler to 
develop the necessary processes to support 
the introduction of Microsoft Office Project 
Portfolio Server 2007. We also completed 
the configuration through the use of an 
iterative process of gathering requirements, 
configuring the tool, reviewing and validating 
the configuration, and making any necessary 
revisions.  After completing the configuration 
and knowledge transfer to Osler’s PMO, training 
sessions were held with key users.  The training 
sessions focused on how to use the new tool 
in an integrated way with the newly developed 
processes.

Solution 

The solution was migrated from a development 
environment to a production environment and is 
now in use at the firm. It supports the gathering 
of all relevant business case information as well 
as identifying the optimal selection of projects 
delivering maximized portfolio value. Multiple 
portfolio selection criteria such as strategic 
value, financials and risk are used in the various 
analyses.

Impact 

The introduction of Microsoft Office Project 
Portfolio Server 2007 along with the processes 
necessary to effectively use the tool has given 
the firm a much clearer sense of the work 
being done and its relative importance to the 
firm’s success. Going forward it will make the 
IT budget and project review process more 
focused, less emotional and more strategic in 
its approach and results.

Technical Drill-down – Microsoft SQL 
Server 2008

The latest version of this product will be 
released this fall and will include significant 
upgrades in scalability, performance, 
application integration and business 
intelligence.  Our technical architects will 
provide information and demos of the most 
interesting new features.

Customer 
Case Study

Osler, Hoskin  
& Harcourt LLP

Microsoft 
Office Project 

Portfolio Server 
Implementation

Business Intelligence for Sales & Marketing 

Winning organizations today are those that can 
target their specific customers and anticipate 
their needs. Information within organizations 
and technology innovations have made this 
possible today.

The highest value concepts will be illustrated 
through a real life implementation and additional 
demos.

Upcoming 
Events

Look for email invitations 
for the following events 

to be held in the  
Fall of 2008.
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